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	MOTIVATION

This case study introduces advanced techniques in dashboard design with SAP Crystal Dashboard Design. You will learn how to use different maps for visualization and how to structure information on a dashboard using container components.
Furthermore, you are introduced to the concept of dynamic visibility. After completing this case study, you should be able to create advanced dashboards using the introduced components.
	
	PREREQUISITES

The fundamental understanding of SAP Crystal Dashboard Design is a prerequisite for the students, covered in chapters ‘Introduction’, ‘Basic Concepts’ and ‘Advanced Techniques’. 
  
LECTURE NOTES

This case study is based on SAP Crystal Dashboard Design and Excel 2007. As a prerequisite each student should have the excel file Benchmarking.xls that includes the spreadsheet model used for this case study.  





Business Scenario


You are the assistant of Global Bikes’ global sales manager. The sales manager was pleased with the first dashboard you created for him, and now he requests a second dashboard, covering following requirements:
On a yearly base, sales organizations over the USA, Australia and Europe are benchmarked against each other to find out how the sales organizations perform. For a general overview on the sales organizations worldwide, their location should be shown geographically on a worldwide map and on a detailed map for each region. Above that, gross sales and pieces sold should be displayed for each sales organization.
Beside this geographical overview, the global sales manager wants to compare sales organizations within one region by profit margin, costs and discount. Furthermore, he wants to compare the number of bikes sold within a region with the worldwide number of bikes sold.

As this is quite a lot of information, you decide to split up the dashboard into two different views that can be selected using a tab set.

· The first tab covers the geographical overview including a worldwide map and three regional maps for the USA, Germany and Australia. By selecting a region from the map, the sales organization of this region is displayed including the gross sales and the pieces sold by this sales organization. As there is not enough space to show all four maps at the same time, you decide to use dynamic visibility for the maps. By using this technique, the user is able to select from a radio button menu which map he wants to be displayed. 
You draw the first outline for this tab in PowerPoint, and this is the result:
 (
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· The second tab covers a more detailed comparison of sales organizations within one region. The user should be able to select the region using a dropdown menu that includes Australia, Germany or USA as selection.    
You draw the first outline for this tab in PowerPoint, and this is the result:


[image: Bench_all]

The sales manager is happy with this first outline, and you create the spreadsheet model you are going to use. After the spreadsheet model is finished, you start implementing the dashboard in SAP Crystal Dashboard Design.


Task 1: Create a new SAP Crystal Dashboard Design project and import a spreadsheet
Short description: You create a new SAP Crystal Dashboard Design project that is based on an existing spreadsheet including the global sales data. 


1. Please start SAP Crystal Dashboard Design (Xcelsius):

Start → Programs → Xcelsius → Xcelsius 2008

2. You are going to use an existing spreadsheet model. Therefore you have to import the spreadsheet model Benchmarking.xls into SAP Crystal Dashboard Design. Your lecturer will provide this spreadsheet.

Data → Import → Conform pop-up in case you are asked if you want to continue → Select Excel Benchmarking.xls → Open 

The benchmarking data is now available in the embedded spreadsheet of SAP Crystal Dashboard Design. It includes two tabs, one tab used for the maps and one tab used for the details:

[image: ]


3. Set the canvas size in pixels to 640 * 480.

File → Document Properties → Preset Size = 640 *480

4. Save the SAP Crystal Dashboard Design project on your desktop.

[bookmark: OLE_LINK1][bookmark: OLE_LINK2]File → Save as → Benchmarking_##.xlf



	Task 2: Create a headline and a tab set with two tabs

	
Short description: You create a title for your dashboard and a tab set including two tabs. 
	[image: 1_Bench_leer.jpg]




1. Create a headline for your dashboard, including the title “Benchmarking Sales Organizations” on the top left side and the company name “Global Bike Inc.” on the top right side. Use two text labels for this task. Assign a white text color and set an appropriate text size in the Properties panel.

2. Rename the labels to Label_title and Label_company in the Object browser.

3. Now add a tab set component to the canvas.

Components panel → Container → Tab Set

Resize the tab set using the mouse so that it covers the whole canvas except the headlines and a small frame on the left, right and bottom side of the canvas.

Open the Object browser and rename Tab Set 1 to Tabset. Your first tab on the tab set is called Canvas 1. Double click on Canvas 1 to edit the label for the first tab. The first tab should be named according to cell B7 in the spreadsheet tab Map. 

	Properties panel – General

	

	[image: ]
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Rename Canvas 1 to Canvas_map. Now you want to add a second tab. Do this by clicking on the plus sign on the top left of the tab set. 

[image: ]

Enter any name for the tab. Go to the Object browser and rename your second tab from Canvas 2 into Canvas_details. The Object browser now looks as following:
[image: ]

The label for the second tab should be “Sales Organization Details“. Link the label of the second tab to the title of the second table of your spreadsheet model, as this table carries the name „Sales Organization Details“. 


4. You do not want to allow scrolling in your tab set, therefore switch off scrolling for each tab (Canvas_maps and Canvas_details) in the Properties panel. 

[image: ]

5. [bookmark: OLE_LINK5][bookmark: OLE_LINK6]Save [image: ] your changes and run the preview [image: ] to check your dashboard. The dashboard should look as follows:

[image: ]



	
Task 3: Create a menu to select one of the four maps

	
Short description: You add a radio button selector with four buttons. The user can select one of these buttons, and then the corresponding map (worldwide, Australia, Germany or USA) is displayed on the canvas.


	[image: 1_Bench_task3.jpg]





1. For this scenario you have to drag a radio button selector component to the first tab “Sales Organization Worldwide” of your tab set. Furthermore, you add four map components to the first tab, including map “Worldwide by continent”, “Australia by region”, “Germany by State”, and “USA (continental)”. 

2. First, you configure the properties of the radio button. Double click on the radio button to open the Properties panel. You have to configure only the General tab. 

Configure the properties as shown below:



	
Properties panel - General
	

	 [image: ]
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3. Dependent on the selection, the position of the selected button is now inserted into cell B4. Each position now has to be linked to a map. In case cell B4 includes a certain status, the linked map is shown, and all other maps are hidden. The positions are as follows:

	Radio Button
	Position in cell B4
	Linked Map

	Worldwide by continent
	1
	World by continent

	Australia
	2
	Australia by region

	Germany
	3
	Germany by state 

	USA
	4
	USA (continental)




4. Go to the Object browser and rename the maps to World, USA, Germany and Australia. Rename Radio button 1 to Radio_button_select. Hide all maps using the Object browser, except the World map. The Object browser now should look as follows:

[image: ]

5. Arrange the World map on the bottom left of the tab, and configure the settings for the map in the Properties panel as follows:

	a) Properties panel – General

	

	[image: ]
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b) Properties panel – Behavior

	

	 (
no selection
)[image: ]
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6. [bookmark: OLE_LINK3][bookmark: OLE_LINK4]Now hide the world map and activate the Australia map. Position the Australia map on the bottom left of the tab, and configure the settings for the map as follows:

	a) Properties panel – General

	

	[image: ]
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	b) Properties panel – Behavior

	

	 (
no selection
)[image: ]
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7. Now hide the Australia map and activate the Germany map. Position the Germany map on the bottom left of the tab, and configure the settings for the map as follows:

	a) Properties panel – General

	

	[image: ]

	[image: ][image: ]

	b) Properties panel – Behavior

	

	 (
no selection
)[image: ]
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8. 
Now hide the Germany map and activate the USA map. Position the USA map on the bottom left of the tab, and configure the settings for the map as follows:

	a) Properties panel – General

	

	[image: ]
	[image: ][image: ][image: ]



	b) Properties panel - Behavior

	

	 (
n
o selection
)[image: ]
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9. Finally, for each map change the “Selectable Color” to grey in the Properties panel.
[image: ]



10. [bookmark: OLE_LINK9][bookmark: OLE_LINK10]Save [image: ] your changes and run the preview [image: ] to check your dashboard. The dashboard should look as follows:

[image: ]


11. Test the radio buttons and check if each map is displayed. If required, adjust the layout and position of your components.


	Task 4: Add a text field to show the details for a selected region 

	
Short description: By clicking on a selectable area within any of the four maps, the sales organization, gross sales and pieces sold should be displayed in the upper right corner of the tab. Therefore you add a rectangle as frame and the required labels.
	[image: 1_Bench_all.jpg]




1. First you create the frame for the details area. Add a rectangle component to the upper right side of the first tab. Rename the rectangle in the Object browser into Frame_details.

2. In a next step, you create a title for the details area. Drag a label component into the rectangle, and assign the text “Sales Organization” to the label in the labels Properties panel.

3. Now you add a second label component positioned under the first label. This label includes the name of the selected sales organization. The text is dynamically populated from the spreadsheet from cell F23.

[image: ]

4. Finally you add two single value components of type value into the rectangle to display gross sales and pieces sold.

	Value component for gross sales:

	Value component for pieces sold:

	[image: ]
	[image: ]



5. Assign an appropriate name to each component in the Object browser.

6. Save [image: ] your changes and run the preview [image: ] to check your dashboard. The dashboard should look as follows:

[image: ]


7. Check if the details are displayed correctly by selecting different regions on the map.


	Task 5: Add a drop-down menu for the region and a stacked bar chart for the sales organization benchmarking to the second tab

	
Short description: Now you switch to the second tab “Sales Organization Details” and add a drop-down menu that enables the user to select a region. Costs, discounts and profit margin for all sales organizations of the selected region a shown as stacked bar chart.

	[image: 2_Bench_task5.jpg]




1. For this scenario add a combo box selector component to the tab “Sales Organizations Details”. Furthermore, you add a stacked bar chart to the tab.

Hint: For this scenario, you are using data from the second tab (Details) of your spreadsheet! 


2. First, you configure the properties of the combo box. Double click on the combo box to open the Properties panel. You have to configure the General tab of the Properties panel as follows:

	Properties panel – General

	

	[image: ]
	
Add the labels by selecting the displayed range in the spreadsheet. You do not have to maintain the labels manually.


[image: ]




3. Now configure the properties of the stacked bar chart. The data source of your chart is the Destination area populated by the combo box selector component. Double click on the stacked bar chart to open the Properties panel. 

	Properties panel: General

	

	[image: ]
	

	
Series for Costs:
[image: ]
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Series for Discount:
[image: ]
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	Series for Profit Margin
[image: ]
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	Category Labels:
[image: ]
	[image: ]



4. Finally, go to the Layout tab of the Appearance area in the Properties panel and switch off the chart background.

5. Save [image: ] your changes and run the preview [image: ] to check your dashboard. The dashboard should look as follows:

[image: ]



	
Task 6: Add two pie charts to compare the bikes sold within a region with the bikes sold worldwide

	
Short description: Add two pie charts. The pie chart on the left hand side includes the number of bikes sold by the sales organizations within the selected region. The pie chart on the right hand side includes the number of bikes sold within a region compared to other regions.

	[image: Bench_all]




1. First, you add two pie charts to the tab “Sales Organization Details”.

2. Open the Object browser and rename the pie chart on the left hand side to pie_region and the pie chart on the right hand side to pie_world.

3. Open the Properties panel of pie chart pie_region and configure the General tab as shown below:

	a) Properties panel - General
	b) Properties panel - Appearance 


	[image: ]
	[image: ]





4. Open the Properties panel of pie chart “pie_world” and configure the General tab as shown in the following. For this chart, you are using data from the “map” tab of your spreadsheet model.

	a) Properties panel - General 
	b) Properties panel - Appearance 


	[image: ]
	[image: ]



	
5. Finally, for each pie chart go to the Layout tab of the Appearance area in the Properties panel and switch off the chart background.


6. Save [image: ] your changes and run the preview [image: ] to check your dashboard. The dashboard should look as follows:


[image: ]




























	Task 7: Export your dashboard into PDF

	
Short description: You are now happy with your dashboard and you want send it to your boss. Therefore you export your dashboard to PDF. 

	
[image: ]



1. File → Export → Export to pdf

2. Open the PDF document and check your dashboard.
© 2010 SAP AG                        		 Page 1
image4.jpeg
Benchmarking Sales Organizations Global Bike Inc.

Sales Organizations Worldwide Sales Organization Details





image5.png
Canvas 1

F Y &

General  Behavior  Appearance

Label

Maples7 13}

< m [





image6.png
ol=|n|e

Continent
‘Worldwide

sales Organization
UsA




image7.png
Benchmarking Sales Organizations

Sales Organizations Worldwide





image8.png
Object Browser

Tabset

Canvas_map

Canvas_detals
A Label e
A Label_company

o=




image9.png
Canvas_map

= R

General  Behavior  Appearance

Scroll Bar Options

Horizortal Scoll Bar: | Off

Vertical Scrol Bar: off





image10.png




image11.png
>3 Preview




image12.png
Benchmarking Sales Organizations Global Bike Inc.

Sales Organizations Worldwide





image13.jpeg
Benchmarking Sales Organizations Global Bike Inc.

Sales Organizations Worldwide | Sales Organization Details

Display Sales Organizations:
Worldwide by continent

®  Australia
*+ Germany
. UsA





image14.png
Radio Button 1

i

G

it

H R
T8 W R

reral | Behavior  Appearance

Display Sales Organizations

Labels

Dal

ta Insertion

Insertion Type:

Posiion

Saurce Data:

Destination:

Mapigegs

™




image15.png
Label Name

Australia

Germany

usa

- =





image16.png
Map Status (84)

[ ]




image17.png
Canvas_msp
O ua
O Gemany
O austrsls
O wod

6] Rado_buston_select

{5l Canvas_detals
A Label e
A Lsbel_company




image18.png
i

World by continent

RegionKeys

ot

play Data

Mapl§CHo:9D 11

DataInsertion

Insertion Type:

Row v
Saurce Data: MapISCeBigFoLL
Destination: Mapl$CH23:47423

[ERF NG





image19.png
Region Keys

o





image20.png
Comman | Animations and Effects

Interaction Options

Insert o Mouse Clik

Default Selected Regian

Region: africa

Dynamic isbiity

Show companent oly F status matches key:
Status: MapiBgt

Key f

EQE]




image21.png
i

Australia by region

RegionKeys

ot

E—

play Data

Mapi§CH18:4D520

DataInsertion

Insertion Type:
Row
Saurce Data:

Destination:

Mapl§CHE:FI20

Mapl$CH23:47423

# = @




image22.png
Region Keys |

Region Regon Key.

New South Wales New South Wales

Northern Terary
Queensand Queensiand
South pustrala

Tasmaria

vitria victaria

Western Australia





image23.png
Common || Animations and Effects.

Interaction Options

Insert o Mouse Clik

Default Selected Regian

Region: New South Wales

Dynamic isbiity

Show companent oly F status matches key:
Status: MapiBgt

Key 2

&R




image24.png
i

(Germany by state.

RegionKeys

ot

play Data

Mapl4CH15:4D817

DataInsertion

Insertion Type:
Row
Saurce Data:

Destination:

MapI§CHIS:RE17

Mapl$CH23:47423

[ERFNE)





image25.png
Regon Region Key
Bayern Bayern
Berin Berin
Erandenturg

Eremen





image26.png
Sachsen
Sachsen-anhalt Sachsen-anhalt
Schleswig-Holstein

Thuringen





image27.png
Common | Animations and Effects

Interaction Options

Insert o Mouse Clik

Default Selected Regian

Region: Bayern

Dynamic isbiity

Show companent oly  status matches key:
Status: MapiBgt

Key 3

=&




image28.png
i

USA (continenta)

RegionKeys

ot

play Data

Mapl§CH12:4D514

DataInsertion

Insertion Type:

Row v
Saurce Data: MapI§CHIZ R 14
Destination: Mapl$CH23:47423

& ©





image29.png
Region Regon Key.
Calfornia Calfornia

Colorado




image30.png
Ideho

Tincis Tinois




image31.png
Okizhama





image32.png
Common | Animations and Effects

Interaction Options

Insert o Mouse Clik

Default Selected Regian

Region: alabama

Dynamic isbiity

Show companent oly  status matches key:
Status: MapiBgt

Key 4

&




image33.png
17 ¥l

General  Behavior  Appearance  Alerts
Layaut Text Color
Regoons

Defalt Cobr:
Over Color:
Selected Colr:
Selectable Color:

Border Colr:





image34.png
Benchmarking Sales Organizations

Global Bike Inc.

Display Sales Organizations

(®)Warldwide by continent
Oaustralia
O sermany

Qusa

world by continent





image35.jpeg
Benchmarking Sales Organizations

Global Bike Inc.

Sales Organizations Worldwide

Sales OrganizationDetails

Display Sales Organizations:
Worldwide by continent

® Australia
* Germany
. UsA

Sales Organization:

Australia
Gross Sales: 49,043 TEUR

Pieces Sold: 65432

Clickona
7 region for
1 deaails





image36.png
i Y

General Behavior  Appearance

Text

@ Linkto Cell

Map!$F$23

Apply Cell Formatting




image37.png
value 1

EEEY

General  Behavior  Appearance  Alerts
Tt

(Gross Sales (n TELR)
Data

MapiD$23 NG





image38.png
value 2

General  Behavor  Appesrance  Alerts
THe

Preces sokd ~
oata

vepifes2s NG





image39.png
Benchmarking Sales Organizations Global Bike Inc.

Sales Organization Details

Display Sales Organizations

(®)Warldwide by continent SALES ORGANIZATION:

Bikes and Matorcycles Studio
Oaustralia
Berin

Ogermany

Gross Sales (in TEUR)
Qusa

133777
Pieces Sold
15937

world by continent





image40.jpeg
Benchmarking Sales Organizations

Global Bike Inc.

Sales Organizations Worldwide

[ Sales Organization Details

Select Region:

Costs, Discount and Profit Margin

. Sales Ore. 1 | N
Awmlin V] | Q8 o > | I
sales Org. 3| I





image41.png
Tt

Select Region:

Labels

Data nserton
Inserion Type:
Fitered Rows
Source Data

Destination:

Detail4B45:41$13

Details§B417:$1515

<
ERENE)





image42.png
i
L |

1 Australia x

2 Germany x

3 Ush x
s v





image43.png
Ties

Chart

Costs, Discourt, Profit Mergin

Subtte

DetallgB$17

Value () As:

nTEUR

Category (¥) Axs:

B 2 =2 &




image44.png
© by Series

Name:

Costs

Values(x):

[petalk gt rsio





image45.png
At

Pieces Sold

Costs |
21083 12,288
16578 9,695
14782 8,635




image46.png
© by Series

Name:

Discaunt

Values(x):

[petalkisIg7:51515





image47.png
15
16 Costs iscount

17 12,288 1,664
18 9,695 1,313

19 8,635 1,164




image48.png
© by Series

Costs

Discaunt

Pr

e Margin

Name:

Profit Margin

Values(x):

[petalkisre17drs 15





image49.png
16
17
18
19

Netsales
18,018
14,207
12,677

Profit Margin
5,730
4,512
4,002

P




image50.png
Category Labels(v):

Detailsi§CH17:4C519





image51.png
c
16 sales Organization

17 |Brisbane Bikes and Motoshop

18 |Melbourne Bikes- and Motoshop
19 sidney Moto- and Bike Store




image52.png
Benchmarking Sales Organizations Global Bike Inc.

Sales Organizations Worldwide

Select Region: Costs, Discount, Profit Margin

Australia v Australia

Sidney Moto- and Bike Store 1 costs
Melbourne Bikes- and Motoshop _ Discount
Brisbane Bikes and Motoshop ST L





image53.jpeg
Benchmarking Sales Organizations Global Bike Inc.

Sales Organizations Worldwide ‘ Sales Organization Details

Costs, Discount and Profit Margin
Select Region

; Sales Org. 1
Australia ¥ e
Sales Org. 2
Sales Org. 3
Bikes sold by region Bikes sold worldwide
Australia Worldwide

mBrisbane Bikes- and

ooy  NorthAmerica
= Melbourne Bikes-and
Motoshop B
= Sidney Moto-and Bke

store = Australia





image54.png
Ties

Dal

Chart

Bikes sold i region

Subtte

DetallgB$17

ta

Values:

Detaili§G$17:4G$19

O patainkows
Labels

© patain Columns

Detailsi§CH17:4C519





image55.png
oo | seres | Tex | colr

Show | Text
Chart Tie

Sub Tile

Mouse-Over Values:

Format Selected Text

verdana v [ v

][]y





image56.png
Ties

Chart

Bikes sold warldide

Subtte

worlduide

Data

Values:

MaplE§O:gE 1L

O patainkows © patain Columns
Labels

Map§CoRigCs1L





image57.png
oo | seres | Tec |

Color

Show | Text

Chart Tie
Sub Tile

Mouse-Over Values:

Format Selected Text

Verdana

E@w





image58.png
Benchmarking Sales Organizations Global Bike Inc.

Sales Organizations Worldwide

Select Region: Costs, Discount, Profit Margin

Australia |~ Australia

Sidney Moto- and Bike Store 1 costs
Melbourne Bikes- and Motoshop _ Discount
Brisbane Bikes and Motoshop S T L

in TEUR

Bikes sold in region Bikes sold worldwide
Australia worldwide
1 risbane Bikes and Hotoshop . North America
" Malbourne bikes- and Hatoshop = Europe
 Sidney Moto- and bike Store  ustralia





image59.png




image1.png




image2.jpeg
Benchmarking Sales Organizatio

Global Bike Inc.

Sales Organizations Worldwide

Sales Organization Details

Costs,

Select Region:
Australia ¥ SalesOrg, 1
Sales Org. 2
Sales Org. 3

Bikes sold by region
Australia

W Brisbane Bikes- and

Motoshop

m Melbourne Bikes- and
Motoshop

HSidney Moto-and Bike
store

Discount and Profit Margin

Bikes sold worldwide
Worldwide

W North America

m Europe

= Australia





image3.png
% Untitled - Xcelsius 2008

d9-c-0)-

Start  Einfigen  Seitenlayout  Formein  Daten  Uberprifen  Ansicht  Entwicklertools  Adddns

Continent Region Code Gross Salesin TEUR PiecesSold Sales Organization
Worldwide  North America 37,778 43273 USA

Worldwide  Europe 39,907 Germany

Worldwide  Australia 43,083 Australia

North America__ illinois 12,200 ilinois Bikes and Motoshoj





